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PSoC® 5LP 入門
著者: Nidhin MS
関連製品ファミリ: PSoC 5LP の全製品
関連資料: 資料の完全なリストについては、 ここをクリックしてください。
本アプリケーション ノートの最新版または関連するプロジェクト ファイルについては、
http://www.cypress.com/go/AN77759 をご覧ください。
本アプリケーション ノート (AN77759) では、ARM® Cortex®-M3 ベースのプログラム可能なシステムオンチップである
PSoC® 5LP について紹介します。この文書で、PSoC 5LP のアーキテクチャおよび開発環境を説明し、PSoC 5LP の開発
ツールである PSoC Creator™を使用して簡単なデザインを作成する方法を示します。また、本アプリケーション ノートは
PSoC 5LP と一般的な PSoC を深く理解できるようなリソースを提供します。
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はじめに
PSoC 5LP は、単一チップ上にカスタムのアナログとデジタルの周辺機能、メモリ、および ARM Cortex-M3 CPU を集積した、真
のプログラマブルな組み込みシステム オン チップです。
PSoC 5LP は、MCU と外部 IC の組み合わせに代わるコスト効率の良いソリューションを提供しています。PSoC 5LP アーキテク
チャは下記によって性能を向上させます。




80 MHz までの 32 ビット ARM Cortex-M3 コア、DMA コントローラーおよびデジタル フィルター プロセッサ
超低消費電力、業界最大の電圧範囲に対応
プログラマブルなデジタルおよびアナログ ペリフェラルでカスタム機能を実現可能
任意のアナログまたはデジタル ペリフェラル機能から、任意のピンまでの柔軟性の高いルーティング
単一の PSoC デバイスは 100 個までのデジタルおよびアナログ ペリフェラル機能を統合することができ、設計時間、基板面積、
消費電力およびシステム コストを低減しながらシステムの品質向上を実現します。
本書の使用法
これより数ページで PSoC 5LP、および PSoC と PSoC Creator で設計する利点について説明します。はじめての PSoC 5LP
デザインまでとばして、簡単なデザインを迅速にビルドすることもできます。そのセクションで作成するデザインはサンプル コード
CE203303 にもあります。
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文書番号: 001-97882 Rev. *A
1
®
PSoC 5LP 入門
2
PSoC リソース
サイプレスは、www.cypress.com に大量のデータを掲載しており、ユーザーがデザインに対して適切な PSoC デバイスを選択し、
迅速に効率的にデバイスをデザインに統合するための手助けをしています。リソースの包括的なリストについては、 KBA86521,
How to Design with PSoC 3, PSoC 4, and PSoC 5LP をご参照ください。以下は PSoC 5LP のリソースの要約です。
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概要: PSoCポートフォリオ、PSoCロードマップ
製 品 セ レ ク タ ー : PSoC 1 、 PSoC 3 、 PSoC 4 ま た は
PSoC 5LP。それに加えて、PSoC Creatorにはデバイス
選択ツールが含まれています。
データシート: PSoC 3、PSoC 4、PSoC 5LPデバイス
ファミリ用の電気的仕様を説明します。
CapSense® デザイン ガイド: PSoC 3、PSoC 4、および
PSoC 5LPファミリのデバイスを使用して静電容量タッチ
センシング アプリケーションを設計する方法について
説明します。
アプリケーション ノートおよびサンプル コード: 基本レベル
から高度なレベルまでの幅広いトピックを提供します。
多くのアプリケーション ノートはサンプル コードを含み
ます。



テクニカル リファレンス マニュアル (TRM): PSoC 3、
PSoC 4、PSoC 5LPデバイス ファミリのアーキテクチャ
とレジスタの詳細な説明を提供します。
PsoCトレーニング動画: これらの動画はPSoCを用い
て、複雑なデザインをビルドする方法に関するステップ
バイ ステップ指示を提供します。
開発キット:
□
CY8CKIT-059はPSoC 5LPデバイスをサンプリング
するための低コストのプロトタイプ プラットフォーム
です。
□
CY8CKIT-050 はアナログ性能を実現するように設
計されています。これにより、高精度アナログ、低消
費電力かつ低電圧のアプリケーションを評価、開発
することが可能になります。
PSoC Creator
PSoC Creator は無料の Windows ベースの統合設計環境 (IDE) です。このキットにより、PSoC 3、PSoC 4、および PSoC 5LP
ベースのシステムについて、ハードウェアとファームウェアの同時並行の設計が可能です。図 1 に示すように、PSoC Creator に
より、以下のことが可能です。
1.
メイン デザイン ワークスペースでコンポーネント
をドラッグ & ドロップして、ハードウェア システム
デザインを構築
2.
PSoC ハードウェアとアプリケーション ファーム
ウエアを同時設計
3.
コンフィギゥレーション ツールを用いて、コンポー
ネントをコンフィギゥレーション
4.
100 以上のコンポーネントのライブラリを利用
5.
コンポーネント データシートをレビュー
図 1. PSoC Creator の主要点
www.cypress.com
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3.1
PSoC Creator ヘルプ
PSoC Creator ホーム ページへアクセスして PSoC Creator の最新版をダウンロードしてください。次に、PSoC Creator を起
動して、以下のアイテムへナビゲートします。
3.2

Quick Start Guide (クイック スタート ガイド): メニューから Help > Documentation > Quick Start Guide を選択します。
このガイドは PSoC Creator プロジェクトを開発するための基礎知識を提供します。

Simple Component example projects (簡単なコンポーネント サンプル プロジェクト): メニューから File > Open >
Example projects を選択します。これらのサンプル プロジェクトは、PSoC Creator のコンポーネントの設定と使用方法を
示します。

Starter designs (スターター デザイン): メニューから File > New > Project > PSoC 5LP Starter Designs を選択します。
これらのスターター デザインは、 PSoC 5LP のユニークな機能を示します。

System Reference Guide ( シ ス テ ム リ フ ァ レ ン ス ガ イ ド ): メニ ュ ーか ら Help > System Reference > System
Reference Guide を選択します。このガイドは、PSoC Creator により提供されるシステム機能を一覧にして、説明します。

Component datasheets (コンポーネント データシート): メニューから Component を右クリックして「Open Datasheet」を
選択します。すべての PSoC 5LP のコンポーネント データシートの一覧については、 PSoC 5LP コンポーネント データシートの
ページへアクセスしてください。

Document Manager (ドキュメント マネージャー): PSoC Creator は、ドキュメントリソースを容易に見つけレビューするのを助け
るために、Document Manager を提供します。Document Manager を開くには、メニューアイテムから Help >Document
Manager を選択します。
テクニカル サポート
ご質問は、弊社のテクニカル サポート チームが対応いたします。 Cypress Technical Support ページにアクセスし、サポート
リクエストを作成してください。
米国のお客様は、弊社フリーダイヤル (+1-800-541-4736 ext.8) までお電話ください。テクニカルサポートチームと電話で話す
ことができます。
早急な対応が求められる場合は、以下のサポート リソースをご利用ください。


セルフヘルプ
お近くの販売代理店
www.cypress.com
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図 2. PSoC Creator のサンプル コード
4
サンプル コード
PSoC Creator は多数のサンプル コード プロジェクトを含んでいます。これらのプロ
ジェクトは、 図 2 に示すように、PSoC Creator のスタート ページからアクセスでき
ます。
サンプル プロジェクトにより、新規からではなく完成した設計で始めるため、設計時
間を短縮させることができます。また、サンプル プロジェクトは、PSoC Creator コン
ポーネントを様々なアプリケーションに使用する方法も示します。図 3 に示すように、
サンプル コードおよびデータシートが含まれています。
図 3 に示す「Find Example Project」ダイアログには、いくつかのオプションがあり
ます。

ア ー キ テ ク チ ャ ま た は デ バ イ ス フ ァ ミ リ ー (PSoC 3 、 PSoC 4 ま た は
PSoC 5LP)、カテゴリ、またはキーワードに基づいてサンプル プロジェクトを
フイルターします。



「Filter Options」にもとづいて提供されたサンプル プロジェクトから選択します。

選択に応じて新規プロジェクト (また、必要な場合は新規ワークスペース) を作
成します。これにより、完成した基本設計で開始するため、設計時間を短縮さ
せることができます。そのようにして設計をアプリケーションに適合させることが
可能です。
選択のためにデータシートをレビューします ( Documentation タブ上で)。
選択のためにサンプル コードをレビューします。このウィンドウからコードをプロ
ジェクトにコピー アンド ペーストして、コード開発時間を短縮することができます。
図 3. サンプル プロジェクトおよびサンプル コード
www.cypress.com
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PSoC 5LP 機能セット
PSoC 5LP は、図 4 (CY8C58xxLP デバイス ファミリの場合) に示すように 、CPU とメモリ サブシステム、デジタル サブシステム、
アナログ サブシステム、システム リソースを含む幅広い機能を備えています。
詳細については、前の節でリストアップされた PSoC 5LP ファミリ デバイス データシート、テクニカル リファレンス マニュアル(TRM)
およびアプリケーション ノートをご参照ください。
図 4. PSoC 5LP アーキテクチャ (CY8C58xxLP)
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PSoC 5LP の主要な機能の一覧は以下の通りです。詳細については、関連資料または PSoC 5LP デバイス データシートをご参
照ください。


パフォーマンス



DC～80MHz で動作

24 ビット、64 タップのデジタル フィルター プロセッサ
(DFB)
32 ビット ARM Cortex-M3 CPU、32 個の割り込み
24 チャネルのダイレクト メモリ アクセス (DMA) コントロー
ラー
www.cypress.com
メモリ
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最大 256KB のプログラム フラッシュ
エラー訂正コード (ECC) 用の最大 32KB の追加フラッシュ
最大 64KB の SRAM
2KB の EEPROM
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デジタル周辺機能
汎用性の高い I/O システム

4 個の 16 ビット タイマー、カウンター、PWM
(TCPWM)





I2C、1Mbps のバス速度

最大 8 個までのパフォーマンス I/O (SIO) ピン
USB 2.0 認定、フル スピード (FS) 12Mbps

25mA の電流シンク
フル CAN 2.0b、16 個の Rx、8 個の Tx バッファ

プログラム可能な入力閾値および出力 HIGH 電
圧

汎用アナログ コンパレーターとして動作可能

ホット スワップ機能および過電圧許容
20～24 個のユニバーサル デジタル ブロック
(UDB): 任意の数の機能を作成するようプログラム
可能

8 ビット、16 ビット、24 ビット、および 32 ビットの
タイマー、カウンター、および PWM

I2C、UART、SPI、I2S、LIN 2.0 インターフェース

巡回冗長検査回路 (CRC)

擬似乱数列 (PRS) ジェネレータ

直交デコーダ

ゲート レベルのロジック機能
アナログ サブシステム

8～20 ビットのコンフィグレーション可能なデルタシグマ ADC





最大 2 個の 12 ビット SAR ADC


46～72 個の I/O ピン – 最大 62 個までの汎用 I/O
(GPIO)

4 個のコンパレーター
4 個の演算増幅器 (オペアンプ)
下記を作成するための 4 個のプログラマブルなア
ナログ ブロック
プログラマブル ゲイン アンプ (PGA)

トランスインピーダンス アンプ (TIA)

ミキサー

サンプル／ホールド (S/H) 回路
GPIO として使用可能な 2 個の USBIO ピン

任意の GPIO から LCD 直接駆動、最大 46×16 セ
グメント


任意の GPIO から CapSense をサポート
任意のデジタルまたはアナログ ペリフェラルから任
意の GPIO への接続
1.2V～5.5V のインターフェース電圧、最大 4 個の
パワー ドメイン
プログラム可能なクロッキング






4 個の 8 ビット DAC



3MHz～74MHz の内部発振器、3MHz で精度が 1%
4MHz～25MHz の外部水晶発振器
内部 PLL クロック生成、最大 80MHz
低消費電力内部発振器、1KHz、33KHz、100KHz
32.768kHz の外部時計用水晶発振器
12 個のクロック分周器-任意のペリフェラルまたは
I/O にルーティング可能
PSoC 5LP 機能の全面的なレビューについては、データシー
トをご参照ください。
CapSense®サポート、最大 62 個のセンサー
1.024V±0.1%の内部電圧リファレンス
www.cypress.com
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5.1
PsoC の MCU より優れている点
図 5 に示すように、標準的な MCU は、CPU、および ADC、DAC、UART、SPI 等の周辺機能、および汎用 I/O を含んでいます。
これらはすべて CPU のレジスタ インターフェースにリンクします。MCU の中では、CPU がデバイス の「心臓」です。CPU は
セットアップ、データ移動、タイミングのすべてを管理します。CPU がないと、MCU は動作不可能です。
図 6 に示すように、PSoC は全く違います。CPU、アナログ、デジタルおよび I/O は、プログラマブルなシステムで同等に重要な
リソースです。 PSoC の心臓は CPU ではなく、システムの相互接続とプログラマビリティです。アナログとデジタル ペリフェラル
は高度にコンフィギュレーション可能な配線マトリックスと相互接続されます。これにより、ユーザーはアプリケーションの要件を
正確に満たすカスタム設計を作成することができます。PSoC をプログラムして MCU をエミュレートできますが、MCU をプログラム
して PSoC をエミュレートすることはできません。
図 5. 標準 MCU のブロック図
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図 6. PSoC 5LP のブロック図
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標準的な MCU は、ステート マシンを処理し、タイマーをタイミングに使用し、出力ピンを駆動するために、CPU ファームウェアを
必要とします。従って、機能的パスはたいていいつも CPU を介します。しかし、PSoC を用いると非同期の平行処理が可能です。
PSoC のコンポーネントが CPU から独立して動作するように設定可能です。
例えば、図 6 は、UART がない PSoC 5LP を示します。しかし、ユーザーは、PSoC Creator の予め設計および予めテストした
UART コンポーネントを使って、コンフィギュレーション可能なデジタル ロジックの範囲内で必要とする UART 数だけ作成すること
ができます。また、それぞれの UART が必要とするだけの機能を持つように設定できます。
5.2
PSoC Creator コンポーネントの概念
PSoC デザインが成功するための鍵となるのは PSoC Creator IDE です。PSoC Creator は、「コンポーネント」と呼ばれている
グラフィック要素としての PSoC ペリフェラルと他のリソースを含んでいます。コンポーネントは回路図にドラッグ & ドロップされ、
互いに接続されるため、設計を迅速で簡単にできます。設計の変更は数回のマウス クリックだけで即座に実現できます。
例えば、従来の MCU では、PWM ペリフェラルを使用して LED を点滅させるには、次の操作を行わなければなりません。
1. PWM に対応するレジスタの位置を確定。
2. 要求される PWM 周期およびデューティ比に基づいて、PWM レジスタに書き込まれる値を計算。
3. PWM レジスタを設定して、ピン ドライブ モードを設定し、PWM 出力をピンに接続するための数多くのコード行を書く。
PSoC で同様な機能を実装するには、本アプリケーション ノートの次の節で説明するように、簡単な操作です。
www.cypress.com
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ピン コンポーネント: 任意の機能を任意のピンに接続
PSoC 5LP は広大な配線構造を含み、ほとんどの機能 (デジタルまたはアナログ) を任意のピンに接続することができます。
PSoC Creator が提供するピン コンポーネントを利用すると、数回のマウス クリックだけで設定を完成させ、PSoC リソースに
接続し、物理ピンに接続できるため、機能とピンの接続は簡単になります。また、ピン コンポーネントの接続を簡単に変更できる
ため、基板レベルの設計の変更を迅速に処理できます。
プログラマブルなデジタル リソースに基づくコンポーネント
PSoC 5LP には、ユニバーサル デジタル ブロック (UDB) と呼ばれるプログラム可能なデジタル ブロックがあります。PSoC
Creator は UDB から作られた多くのコンポーネントを提供します。UART、SPI、I2C 、I2S、タイマー、PWM、カウンター、CRC、
直交デコーダ、デジタル ゲート (AND、OR、NOT、XOR など) を始め、他にも多くのものが含まれています。さらに、自分のカスタム
ステート マシンおよびデジタル ロジックを作り上げることが可能です。
プログラマブルなアナログ リソースに基づくコンポーネント
PSoC 5LP には、スイッチト キャパシタ連続時間 (SC/CT) ブロックと呼ばれるプログラム可能なアナログ ブロックもあります。
PSoC Creator は、プログラマブル ゲイン アンプ (PGA) やトランスインピーダンス アンプ (TIA) のような SC/CT ブロックから
作られたアナログ コンポーネントを提供します。
6
はじめての PSoC 5LP デザイン
この節の内容は以下の通りです。



6.1
従来の MCU ができる以上のことを行うために、どのように PSoC がプログラムされ得るかを示します。
単純な PSoC 設計のビルド方法、その設計を開発キットにインストールする方法を示します。
PSoC Creator IDE を使って、PSoC 設計技術の学習を容易にする詳細な手順を提供します。
始める前に準備するもの
PSoC Creator をインストールしましたか？
PSoC Creator ホーム ページから PSoC Creator をダウンロードし、インストールします。インストールに時間がかかることが
あります。詳細については、PSoC Creator リリース ノートをご参照ください。
開発キットを持っていますか？
表 1 に PSoC 5L P 用のすべてのサイプレス開発キットを示します。他のメーカーのキットも利用できます。
表 1. サイプレスの PSoC 5LP キット
PSoC 5LP キット
PSoC 5LP デバイスの製品番号
プログラミング
CY8CKIT-059
CY8C5888LTI-LP097
プログラマを内蔵
CY8CKIT-050
CY8C5868AXI-LP035
プログラマを内蔵
CY8CKIT-001
CY8C5868AXI-LP035
MiniProg3 プログラムおよびデバッグキット
実行中のプロジェクトをご覧になりたいですか？
次のセクションで説明する開発過程が必要ない場合、CE203303 から完成したサンプル プロジェクトをご利用できます。そして、
ビルドおよびプログラムのステップへ進むことができます。サンプル コードは CY8CKIT-059 向けに設計されますが、他のキット
のために簡単に修正できます。
www.cypress.com
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6.2
デザインについて
このデザインは「CE203303-PSoC 3 and PSoC 5LP Breathing LED」のサンプル コードで詳しく説明されます。初期化後に
CPU を使わずに「ブリージング LED」効果をハードウェアだけで実装します。図 7 に PSoC Creator の回路図を示します。
図 7. ブリージング LED の回路図 (ピンおよび LED を CY8CKIT-059 用に選択)
6.3
パート 1: デザインの作成
この節は設計の過程について順序を追って説明します。ハードウェアとファームウェア両方の設計エントリについて説明します。
注： これらの手順では、ユーザーが PSoC Creator 3.3 を利用していることを前提にします。全体的な開発過程は、PSoC Creator の
他のバージョンでも同様ですが、ダイアログ ボックスの一部が異なることがあります。
1. 新しい PSoC Creator プロジェクトを作成します。
プロジェクトには、すべてのソース コード、およびターゲットである PSoC 5LP デバイスにダウンロードできる 1 つの出力モジュー
ルを作成するのに必要なファイルが含まれています。
A.
PSoC Creator を起動します。
B.
図 8 に示すように、メニューから
File > New > Project… を選択します。
図 8. 新しい PSoC Creator プロジェクトの作成
「Create Project」ウィンドウが表示されます。
www.cypress.com
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2. CY8CKIT-059 キットのプロジェクトの種類を選択します。 (図 9 を参照)
PSoC Creator は、様々なプロジェクト オプションを特定の開発キットやターゲット デバイス用に自動的に設定することで、
開発時間を短縮させることができます。
A. 「Target hardware」をクリックします。
B.
プルダウン メニューから「Kit: CY8CKIT-059 (PSoC 5LP)」を選択します。
C. 「Next」をクリックします。
図 9. CY8CKIT-059 の新しいプロジェクトを作成
A
B
C
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3. 空の回路図をプロジェクト テンプレートとして選択します。 (図 10 を参照)
PSoC Creator は、既存のサンプル コードに基づいて新しいデザインを作ることで開発時間を短縮させることができます。
この場合では、空の回路図から開始します。
A.
「Empty Schematic」をクリックします。
B.
「Next」をクリックします。
C.
次のダイアログの「Workspace name」にワークスペースの名前を入力します。1 つのワークスペースはいくつかの
プロジェクトを格納できます。プロジェクトは通常、ワークスペースに格納されます。
D.
「Project name」にプロジェクトの名前を入力します。プロジェクト名とワークスペース名は同じでも違っても構いません。
E.
F.
ワークスペースとプロジェクトの「Location」を指定します。
「Finish」をクリックします。
図 10. 新しい空のプロジェクトの作成
A
B
C
D
E
F
プロジェクトが作成されました。いくつかの新しいペインが表示されます: Workspace Explorer、Schematic
(TopDesign.cysch)、および Component Catalog。
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4. デザインのハードウェア部分をビルドします。
このステップでは、コンポーネントを「Component
Catalog」から回路図にドラッグします。その後、
それぞれのコンポーネントを設定し、互いに接続し
ます。
a.
図 11 に示すように、「Component Catalog」
ウィンドウの Cypress タブで、PWM コンポー
ネントを検索します。
b.
PWM コンポーネントの 2 つのインスタンスを
回路図にドラッグします (図 7 を参照)。
www.cypress.com
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5.
PWM コンポーネントを設定します。 (図 12 を参照)
両方の PWM から方形波の出力が生成されますが、方形波の周波数は少し異なります。周波数の差により、LED で変調さ
れるビート周波数が発生します。
回路図で、それぞれの PWM コンポーネントをダブルクリックして設定します。
A.
PWM_1 の PWM Mode を One Output に変更します。
B.
PWM_1 に対する更なる変更は不要です。OK をクリックしてダイアログを閉じます。
C.
PWM_2 の PWM Mode を One Output に変更します。
D.
PWM_2 の Period 値をデフォルト値から少し外れた値に設定します。
E.
PWM_2 の CMP Value 1 を Period 値の約半分に設定します。
F.
PWM_2 の変更が完了しました。OK をクリックして、ダイアログ ボックスを閉じます。
図 12. PWM コンポーネントの設定
C
A
D
E
B
F
6.
表 2 に示す追加のコンポーネントを Component Catalog から回路図にドラッグして設定します。
Off-Chip のコンポーネントは必須ではありませんが、デザインの全体的な目的を示すのに役立ちます。
各コンフィギュレーション ダイアログでは Name フィールドは自動的に挿入される点にご注意ください。他の有効な名前
に変更可能です。回路図で各コンポーネント名は唯一なものでなければなりません。
表 2. デザイン コンポーネント
コンポーネント カタログ
コンポーネント
タブ
グループ
デフォルト設定からの変更
Logic Low
Cypress
デジタル > ロジック
なし
Xor
Cypress
デジタル > ロジック
なし
Clock
Cypress
システム
「Frequency」を 5kHz にセット
Digital Output Pin
Cypress
ポートとピン
「External terminal」ボックスにチェックを入れる
Resistor
Off-Chip
受動コンポーネント
なし
LED
Off-Chip
ダイオード
なし
Ground
Off-Chip
パワー
なし
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文書番号: 001-97882 Rev. *A
13
®
PSoC 5LP 入門
7.
ワイヤー ツールを選択して(図 13 を参照) ロジックを接族
続します (またはショートカットとして「w」を押します)
図 13. ワイヤー ツールの選択
図 7 に示すように、コンポーネントを接続します。
8.
これで、ハードウェアの設計が完成しましたが、ピン コンポーネントを物理ピンに接続しなければなりません。
使用中の開発キット上の LED 用の物理ピンを選択します。 (CY8CKIT-059 の場合、ポート 2 のピン 1 (P2[1]) が使用さ
れます)
A.
図 14 に示すように、Workspace Explorer ウィンドウで、プロジェクト内の.cydwr ファイルをダブルクリックします。
そうすると、「Design wide resource (DWR)」ウィンドウが開きます。
B. 「Pins」タブを選択します。プロジェクトで定義されたピン コンポーネント、およびターゲット デバイスのピンの配置図
が表示されます。
C.
回路図のピン コンポーネントを所望の物理ピンに接続します。
図 14. ピンの割り当て
A
C
B
9.
ここで、数行のファームウェアを書く必要があります。その前に、PSoC Creator が、コンポーネントに関連するすべての
コードを生成するようにします。
図 15 に示すように、PSoC Creator メニューから、Build >
Generate Application を選択します。 エラーがなけれ
ば、PSoC Creator は Generated_Source フォルダにいく
つかのコード ファイルを生成します。
www.cypress.com
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10. コードを自動的に生成したファイル main.c に追加します。コードを追加するためのフレームワークがあります。2 個の
PWM コンポーネントを起動するために追加しなければならないコードは、コード 1 に示すように、ハイライト表示されます。
Workspace Explorer ウィンドウで、プロジェクトの main.c ファイルをダブルクリックして開きます。
注: このコードでは、PWM コンポーネントはデフォルトの名前であることを前提にします。PWM コンポーネントをデフォルト
以外の名前に変更する場合、「_Start()」 関数呼び出しでその名前を使用します。
コード 1. ブリージング LED のメイン コード
#include <project.h>
int main()
{
//CyGlobalIntEnable; /* Enable global interrupts. */
/* Place your initialization/startup code here (e.g. MyInst_Start()) */
PWM_1_Start();
PWM_2_Start();
for(;;)
{
/* Place your application code here. */
}
}
11. 設計過程を飛ばしてこのステップに進んだ場合、以下のようにしてください:
A.
B.
C.
D.
E.
CE203303.zip のサンプル コードのファイルを CE203303 からダウンロードし、コンピューターの使いやすい所に解
凍します。
9 ページの「ステップ 1」に説明したように、PSoC Creator をダウンロードし、インストールします。
PSoC Creator で CE203303.cywrk ファイルを開きます。
15 ページの「ステップ 8」に説明したように、プロジェクトのピン割り当てが開発キット (DVK) に一致することを確認します。
図 16 示すように、PSoC Creator のメニューから
図 16. プロジェクトのビルド
Build > Build <プロジェクト名>を選択します。
エラーがなければ、プロジェクトはビルドされ、
ターゲットの DVK にプログラムできる状態に
なります。
www.cypress.com
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6.4
パート 2: デバイスのプログラム
プログラム過程はすべての開発キット基板で同様です。DVK を設定するために、キット ガイド ドキュメントの説明書に従ってく
ださい。
1.
PSoC Creator とユーザーの DVK の接続を確認します。
図 17 に示すように、PSoC Creator のメニュー
から Debug > Select Debug Target を選択し
ます。
A.
図 18 に 示 す よ う に 、 「 Select Debug
Target」ダイアログが表示されます。ター
ゲ ッ ト の DVK を ク リ ッ ク し ま す (PSoC
Creator は多くの DVK 接続をサポートし
ます) 。
B.
Port Acquire をクリックします。
図 17. デバッグ ターゲットの選択
図 18. プログラム用のターゲットの選択と取得
A
B
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2.
ターゲットの DVK 上の PSoC に接続します。図 19 をご参照ください。
A.
PSoC 5LP をクリックします。
B.
Connect をクリックします。「Target unacquired」メッセージは「Target acquired」に変わり、ボタンのラベルは
「Disconnect」に変更されます。
C.
OK をクリックしてダイアログを閉じます。
これで、PSoC Creator はターゲットの DVK と PSoC に接続し、PSoC をプログラムすることが可能になります。
図 19. ターゲットの PSoC 5LP への接続
A
B
C
3.
図 20 に示すように、PSoC 5LP をプログラムする
ために、PSoC Creator のメニューから Debug >
Program を選択します。
4.
プログラミングが開始します。図 21 に示すように、
プログラミングのステータスは PSoC Creator の
ステータス バー (画面の左下隅) に表示されます。
図 20. デバイスのプログラム
注: 「This programmer is currently out of date
(このプログラマは現在、古いものになりました)」の
警告メッセージが表示される場合があります。
プログラマ ファームウェアをアップグレードする方法
については、キットの資料にある KitProg ユーザー ガ
イドをご参照ください。
図 21. プログラミングのステータス
CY8CKIT-059 DVK では、青色の LED が数秒で徐々に完全 ON から完全 OFF の状態に変わります。
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7
まとめ
本アプリケーション ノートは PSoC 5LP アーキテクチャおよび開発ツールを説明した。本アプリケーション ノートから得られる最も
重要なコンセプトは PSoC が MCU より優れていることです 。PSoC 5LP は、真のプログラマブルな組み込みシステム オン チップです。
そこでは単一チップ上にコンフィグレーション可能なアナログとデジタル ペリフェラル機能、メモリ、および 32 ビット Cortex-M3
CPU が集積されています。
集積した機能と低リーク電力モードにより、PSoC 5LP は低消費電力とコスト効率の高い組み込みシステムとして理想的な選択です。
8
関連資料
表 3 に、PSoC と PSoC Creator の次段階の理解に推奨するシステム レベルの一般的なアプリケーション ノートを示します。
表 3. 一般的なシステム レベルのアプリケーション ノート
文書番号
文書名
AN61290、
AN88619
PSoC 3 and PSoC 5LP Hardware Design Considerations,
®
PSoC 4 Hardware Design Considerations
AN81623
PSoC 3, PSoC 4, and PSoC 5LP Digital Design Best Practices
AN77900、
AN86233、
AN90114
PSoC 3 and PSoC 5LP Low-power Modes and Power Reduction Techniques,
®
PSoC 4 Low-power Modes and Power Reduction Techniques,
®
PSoC 4000 Low-power Modes and Power Reduction Techniques
AN68403
PSoC 3 and PSoC 5LP Analog Signal Chain Calibration
AN57821
PSoC 3, PSoC 4, and PSoC 5LP Mixed-Signal Circuit Board Layout Considerations
AN58827
PSoC 3 and PSoC 5LP Internal Analog Routing Considerations
AN73854
PSoC 3, PSoC 4, and PSoC 5LP Introduction to Bootloaders
AN60616
PSoC 3 and PSoC 5LP Startup Procedure
AN60631
PSoC 3 and PSoC 5LP Clocking Resources
AN77835
PSoC 3 to PSoC 5LP Migration Guide
AN78175、
AN89056
PSoC 3 and PSoC 5LP IEC60730 Class B Safety Software Library,
®
PSoC 4 IEC60730 Class B Safety Software Library
®
®
®
®
®
®
®
®
®
®
®
表 4 に Error! Reference source not found.のデバイス説明に関連するアプリケーション ノート (AN)、サンプル コード (CE)、お
よび知識ベース記事 (KBA) を示します。
表 4. PSoC 5LP 機能に関連する資料
文書番号
文書名
CPU および割り込み
®
AN89610
PSoC 4 and PSoC 5LP ARM Cortex Code Optimization
AN54460
PSoC 3 and PSoC 5LP Interrupts
®
メモリ
CE95313
®
PSoC 3, PSoC 4, and PSoC 5LP Emulated EEPROM Memory
ダイレクト メモリ アクセス (DMA)
®
AN52705
PSoC 3 and PSoC 5LP – Getting Started with DMA
AN84810
PSoC 3 and PSoC 5LP Advanced DMA Topics
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文書番号
文書名
AN61102
PSoC 3 and PSoC 5LP – ADC Data Buffering Using DMA
CE95375
CE95376
SPI Master and DMA with PSoC 3 and PSoC 5LP
®
SPI Slave and DMA with PSoC 3 and PSoC 5LP
®
®
デジタル フィルタ ブロック (DFB)
®
CE95316
Filter From ADC to VDAC Using DFB with PSoC 3 and PSoC 5LP
CE95317
Filter From ADC to VDAC Using DFB in Polling Mode with PSoC 3 and PSoC 5LP
®
I2C
2
®
CE95324
I C LCD with PSoC 3 and PSoC 5LP
CE95314
PSoC 3, PSoC 4, and PSoC 5LP EZI2C
®
USB
AN57294
USB 101: An Introduction to Universal Serial Bus 2.0
AN57473
USB HID Basics with PSoC 3 and PSoC 5LP
AN58726
USB HID Intermediate with PSoC 3 and PSoC 5LP
®
®
®
AN56377
PSoC 3 and PSoC 5LP – Introduction to Implementing USB Data Transfers
AN82072
PSoC 3 and PSoC 5LP USB General Data Transfer with Standard HID Drivers
AN73503
USB HID Bootloader for PSoC 3 and PSoC 5LP
CE95390
USB Audio with PSoC 3 and PSoC 5LP
CE95395
USB MIDI with PSoC 3 and PSoC 5LP
CE95394
USB HID Mouse with PSoC 3 and PSoC 5LP
CE95393
USB Bulk Transfer with PSoC 3 and PSoC 5LP
CE95392
USB Bootloader with PSoC 3 and PSoC 5LP
CE95396
USB UART with PSoC 3 and PSoC 5LP
®
®
®
®
®
®
®
®
コントローラー エリア ネットワーク (CAN)
®
AN52701
PSoC 3 and PSoC 5LP – Getting Started with Controller Area Network (CAN)
CE95282
CAN as Control Node with PSoC 3 and PSoC 5LP
CE95283
CAN as Remove Node with PSoC 3 and PSoC 5LP
KBA86565
Difference Between Full CAN and Basic CAN Mailbox
KBA86566
Acceptance Filter Implementation for CAN Receive Message
KBA86567
Modifying the Full CAN Mailbox’s Identifier in the Program
®
®
ユニバーサル デジタル ブロック (UDB)
®
AN82250
PSoC 3, PSoC 4, and PSoC 5LP – Implementing Programmable Logic Designs with Verilog
AN82156
PSoC 3, PSoC 4, and PSoC 5LP – Designing PSoC Creator
CE95295
®
8-Bit UDB Counter with PSoC 3 and PSoC 5LP
CE95384
16-Bit UDB-Based Timer with PSoC 3 and PSoC 5LP
®
TM
Components with UDB Datapaths
®
®
CE95323
Hardware Fan Control with PSoC 3 and PSoC 5LP
KBA85325
Comparison of Resource Utilization Between PSoC 3 and PSoC 5LP UDBs and Other Vendor CPLDs
KBA86336
Just Enough Verilog for PSoC
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文書番号
文書名
アナログ-デジタル変換器 (ADC)
®
AN84783
Accurate Measurement Using PSoC 3 and PSoC 5LP Delta-Sigma ADC
CE95277
Delta-Sigma ADC in Single-Ended Mode with PSoC 3 and PSoC 5LP
CE95271
Delta-Sigma ADC in Differential Mode with PSoC 3 and PSoC 5LP
CE95276
Sequencing SAR ADC with PSoC 3 and PSoC 5LP
KBA81866
Best Method of Amplification to Get Better Performance from PSoC 3 and PSoC 5LP Delta-Sigma ADC
KBA84753
Choice of Reference Voltage for Accurate ADC Measurements in PSoC 3, PSoC 4 and PSoC 5LP
®
®
®
®
®
デジタル-アナログ変換機 (DAC)
®
AN60305
Using PSoC 3 and PSoC 5LP IDACs to build a better VDAC
AN64275
PSoC 3 and PSoC 5LP: Getting More Resolution from 8-Bit DACs
AN69133
PSoC 3 and PSoC 5LP Easy Waveform Generation with the WaveDAC8 Component
CE95397
Voltage DAC with PSoC 3 and PSoC 5LP
CE95309
Dithered Voltage DAC with PSoC 3 and PSoC 5LP
KBA84732
VDAC8 Output Voltage in PSoC 3 and PSoC 5
KBA83238
Driving an External Load using VDAC in PSoC 3 or PSoC 5
®
®
®
®
®
®
コンパレータ
®
AN60220
PSoC 3 and PSoC 5LP Multiplexed Comparator
CE95292
Analog Voltage Comparator with PSoC 3 and PSoC 5LP
CE95361
Scanning Comparator Using Internal VDAC with PSoC 3 and PSoC 5LP
CE95360
Scanning Comparator Using Common Mode with PSoC 3, PSoC 4, and PSoC 5LP
®
®
®
演算増幅器 (オペアンプ)
CE95339
®
Operational Amplifier (Opamp) with PSoC 3 and PSoC 5LP
プログラマブル アナログ ブロック (SC/CT)
®
AN60321
Peak Detection with PSoC 3 and PSoC 5LP
AN62582
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